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Preface

Welcome to IBM® Sterling:Gentran Director® Connection, 
consisting of IBM® Sterling Connection Manager 6.2, IBM® 
Sterling Commerce:Mail 6.2 and IBM® Sterling 
Gentran:Director® 5.5.

This guide provides information to help you understand the order 
of installation and configuration tasks and the information and 
resources you need before installing or upgrading.

This guide assumes that you are familiar with PCs and Microsoft® 
Windows operating system.

 Product overview Sterling Gentran:Director comprises data translation, process 
control, and communication components. It is designed primarily 
for the translation and communication of EDI and other similar 
types of data.

Task overview If you are a new customer installing Sterling Gentran:Director 
Connection for the first time, follow the instructions in Chapter 1, 
Installation for New Customers.

If you are an existing customer upgrading your Sterling 
Gentran:Director Connection, follow the instructions in 
Chapter 2, Upgrade for Existing Customers.
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What You Should Have Received

Product and
documentation

The Sterling Gentran:Director Connection product and 
documentation are available by way of electronic download and 
CD-ROM. 

If you elected to receive CD-ROMs, your package should include 
the following items:

■ Sterling Gentran:Director Connection CD-ROM

■ Sterling Gentran:Director Connection Documentation CD-
ROM

If you did not receive the following items, please contact IBM 
Customer Support for IBM® Sterling Gentran® products. 

If you elected to download from the Internet, you will have 
received instructions for downloading. You will also need to follow 
the Downloading from the Internet instructions on page 3.

Standards If you have purchased the Application Integration, Sterling 
Gentran:Director Forms Integration or Sterling Gentran:Director 
TDF Integration software, your package will also include the 
following:

■ Sterling Standards for EDI Installation card

■ Sterling Standards for EDI CD-ROM

If you elected to download from the Internet, you will not receive a 
standards CD-ROM. Instead, you will need to use the Standards 
Installation card to download the standards.
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Downloading from the Internet

Download the product
.zip file from the

Internet

To download the product from the Internet: 

1. Find the Sterling Gentran:Director Connection product and 
click Download.

2. In the File Download dialog box, click Save.
3. When the Save As dialog box opens, save the compressed 

product file to the C:\ drive.
4. Decompress the product file.

Download
documentation .zip file

from the Internet

To download the documentation from the Internet: 

1. Find Sterling Gentran:Director Connection documentation 
and click Download.

2. In the File Download dialog box, click Save.
3. When the Save As dialog box opens, save the compressed 

documentation file to the C:\ drive.
4. Decompress the documentation file.
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Customer Support

IBM provides a full range of customer support. Check your 
maintenance contract for details about the type of support you 
have purchased for your product.

Before Contacting
Customer Support

Before contacting IBM Customer Support, review the 
documentation provided with your product. The documentation 
may help you identify or resolve the problem you are 
experiencing.

Ensure that you have the following information ready when you 
contact customer support:

■ Your name and telephone number

■ Your company name

■ Your mailbox number (A mailbox number is assigned to 
customers who have a mailbox on the IBM network.)

■ Your product name and version number

■ Your computer platform

■ A detailed description of the problem, including any error 
messages

■ What led to the problem

■ What actions you have  taken to try to diagnose or solve the 
problem

How to Get Help IBM® Sterling Customer Center provides a wealth of online 
resources that are available around the clock to enrich your 
business experience with Sterling Gentran. By using Sterling 
Customer Center, you gain access to many self-support tools, 
including a Knowledge-Base, Documentation, Education, and 
Case Management. Access Sterling Customer Center at http://
customer.sterlingcommerce.com.

Once logged in, select Support Center from the top navigation 
menu, and then locate Sterling Gentran product-specific support 
information from the left navigation menu.

https://customer.sterlingcommerce.com
https://customer.sterlingcommerce.com
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Additionally, our Customer Support Reference Guide outlines our 
support hours, contact information, and key information that will 
enhance your support experience with us. For detailed 
information about Customer Support, please refer to the 
Customer Support Reference Guide accessible from the login 
page. (http://customer.sterlingcommerce.com)

https://customer.sterlingcommerce.com
https://customer.sterlingcommerce.com


Customer Support

6 May 2011 IBM Sterling Gentran:Director Connection Getting Started Guide



IBM Sterling Gentran:Director Connection Getting Started Guide           May 2011 7

Chapter 1

Installation for New Customers

Installation Roadmap

The following table describes the order of tasks to complete and 
references the following products:

■ IBM® Sterling Gentran:Director® Application Integration

■ IBM® Sterling Gentran:Director® FTP Option 

■ IBM® Sterling Gentran:Director® Forms Integration

■ IBM® Sterling Gentran:Director® TDF Integration

■ IBM® Sterling Standards for EDI



Installation Roadmap

8 May 2011 IBM Sterling Gentran:Director Connection Getting Started Guide

Stage Description Section

1 Complete the three pre-installation 
checklists:

■ Hardware requirements

■ Software requirements

■ Trading partner 
information

Note
For instructions on determining the 
software requirements in the 
checklists, see Frequently Asked 
Questions beginning on page 71.

Getting Ready to 
Install on page 10

2 If your system does not have 
MDAC 2.8 installed, install it from 
the Sterling Gentran:Director 
Connection CD-ROM.

Installing 
Microsoft Data 
Access 
Components on 
page 14

3 Install Sterling Gentran:Director. Installing 
Sterling 
Gentran:Director 
on page 16

Continued on next page

4 Set up mailbox profiles. Setting Up 
Mailboxes on 
page 32

5 If you purchased the Sterling 
Gentran:Director FTP Option, 
install the Sterling 
Gentran:Director FTP Option 
communication scripts.
Otherwise, skip this step.

Installing the 
Sterling 
Gentran:Director 
FTP Option 
Communication 
Scripts on 
page 25
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6 If you installed Sterling 
Gentran:Director Application 
Integration, Sterling 
Gentran:Director Forms 
Integration, or Sterling 
Gentran:Director TDF Integration, 
install the Sterling Standards for 
EDI.
Otherwise, skip this step.

See the Sterling  
Standards for EDI 
card for 
instructions.

7 Log on to Sterling Gentran:Director 
for the first time, using the default 
user ID and password. Change the 
default password. 

Changing the 
Default 
Password on 
page 38

8 Add users to the Sterling 
Gentran:Director system.

Adding Users to 
the System on 
page 40

9 Perform validation tests on the 
system.

Validating your 
system on 
page 43

Stage Description Section
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Getting Ready to Install

Before the installation, you must complete several prerequisites, 
such as installing or upgrading any third-party software to meet 
the minimum requirements for Sterling Gentran:Director. 

Pre-installation
checklists

The following categories of information need to be verified before 
installing Sterling Gentran:Director:

■ Hardware requirements

■ Software requirements

■ Trading partner information

Each of these areas is covered in the pre-installation checklists 
that follow. Complete each checklist and ensure that all 
requirements are met before you install Sterling Gentran:Director. 

Note
If you have questions about how to find some of the software 
information, see Frequently Asked Questions beginning on 
page 71.

Hardware
requirements

 

Hardware Requirements

Requirement met? ( )

150 MB free disk space Yes No 

Processor size and speed: See the 
Microsoft documentation or Web site 
for their recommendations for the 
operating system you are using. The 
Microsoft Web site is: 
http://www.microsoft.com.

Yes No 

Continued on next page
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RAM: See the Microsoft Web site for 
their recommendations for the 
operating system you are using. The 
Microsoft Web site is: 
http://www.microsoft.com.

Yes No 

Hayes®-compatible modem with 
MNP or V.42 support with a minimum 
baud rate of 28800 (higher rate 
recommended)
–or–
Dialup connection to an Internet 
Service Provider (ISP) or a LAN 
connection with ports 110 and 25 
open

Note
If you are planning to connect to a 
VAN other than Sterling Information 
Broker and do not know the protocol 
you need, please contact Customer 
Support. See Customer Support on 
page 4.

Yes No 

CD-ROM drive (Required for 
installation, optional for updates.)

Yes No 

DVD drive (Optional for installing 
Standards updates. You can also  
download them from the Sterling 
Support Center Web site.)

Yes No 

SVGA color monitor Yes No 

Mouse Yes No 

Hardware Requirements

Requirement met? ( )
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Software requirements

Software Requirements

Requirement Met? ( )

Operating System:
Must be one of the following operating 
systems, at the version and service 
pack level listed.
■ Windows 2000 Professional, 

v. 5.0, SP4

■ Windows XP Professional, v. 1.0, 
SP2

Yes No 

Microsoft Data Access Components 
(MDAC) v. 2.8 or higher

Note
MDAC v. 2.8 is included on the Sterling 
Gentran:Director Connection product 
CD-ROM. See Installing Microsoft 
Data Access Components on 
page 14 for installation instructions. 
To determine which version of MDAC 
you have, see Frequently Asked 
Questions beginning on page 71.

Yes No 

Microsoft Internet Explorer 5.0 or 
higher

Yes No 
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Trading partner
information

Information to get from your Trading Partner

Information Example
Requirement Met? 

( )

Trading Partner 
Name

ABC Company Yes No 

Document(s) you 
will be trading 
with this partner

850 Purchase Order 
or 810 Invoice

Yes No 

Standards ANSI, UCS, VICS, or 
EDIFACT

Yes No 

Template Version 3020, 3040, or 4010 Yes No 

Trading Partner 
EDI Qualifier

01, 12, 08, or ZZ Yes No 

Trading Partner 
EDI Code

Duns number or 
telephone number

Yes No 
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Installing Microsoft
Data Access

Components

To install the Microsoft Data Access Components v. 2.8, complete 
the following steps. 

Reference
If you are not sure whether you need to install v. 2.8, see How do 
I find out what version of MDAC is running on the computer? 
on page 72

Step Action

1 Turn on your PC and close any open applications.

Note
You may be prompted to reboot after the installation is 
complete.

2 Insert the Sterling Gentran:Director Connection 
product CD-ROM into your CD-ROM drive. 

System response
The Sterling Gentran:Director Connection splash 
screen is displayed. 

3 Navigate to the Mdac folder. 

4 Double-click the file named mdac_typ.exe. 

System response
The MDAC installation program End User License is 
displayed.

5 After reading the license, select the check box and 
click Next. 

System response
The setup program checks for available disk space 
and programs or files on your system that it will 
replace but that are currently in use by another 
program. 

Continued on next page
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Preparing for the
Remote Installations

Call

Once your system meets all the prerequisites, you are ready for 
your installation call with the Remote Installations group. If you 
have not set a date for the installation, please call the Remote 
Installations group at 877-432-4300 (option 5) to speak with a 
Remote Installations analyst and set up an appointment. 
The Remote Installations analyst may request that you fax your 
completed checklists. This allows them to review the checklists 
with you and become familiar with your system and software. The 
analyst will give you the fax number.

6 If Setup finds files that are in use, it will warn you that 
you need to reboot the PC after setup is complete. 
Click Next. 

System response
The Installing the Software screen is displayed.

7 Click Finish.

8 When the MDAC setup is complete, you are prompted 
to choose whether to let the Setup program reboot the 
system immediately or to end Setup and reboot 
manually later. 
Choose the option desired and click Finish.

9 If you chose to have Setup reboot the system now, the 
system is rebooted. Log on to the system as usual. 
If you chose to reboot the system yourself, the Setup 
program exits. 

Step Action
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Installing Sterling Gentran:Director 

Make sure you have
the following items

■ The Sterling Gentran:Director Connection CD-ROM

Note: 

If you downloaded Sterling Gentran:Director 5.5 from 
the Internet, start with Step 4 in the procedure below. 

■ The completed pre-installation checklists from this guide

■ An ISP user ID and password (if applicable)

■ A Local Area Network ID(s) and password(s) (if applicable)

■ If you are upgrading, a IBM mailbox ID and password

Procedure Note: 

The Sterling Gentran:Director Executive icon has 
changed to an IBM logo that appears in your system tray. 

To install Sterling Gentran:Director, complete the following steps:

Step Action

1 Turn on your PC and close any open applications.
Note:
Sterling Gentran:Director is designed/licensed to be 
installed to a local drive. If you need to use Terminal 
Server or any other type of remote desktop tool to 
install or implement Sterling Gentran:Director, please 
contact your IBM Sales Representative to discuss 
other IBM products that are designed for you 
environment and needs. The use of any remote 
desktop tool with Sterling Gentran:Director could 
produce undesirable results which will impact your 
business and will suspend your support of Sterling 
Gentran:Director, from IBM Customer Support, until 
the software is loaded in a supportable environment.
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2 Insert the Sterling Gentran:Director Connection 
product CD-ROM into your CD-ROM drive. 

System response
The Sterling Gentran:Director Connection Welcome 
screen is displayed.

Note
If the Welcome screen does not appear, go to step 4.

3 Click Next and go to step 5.                                               

4 From the Start menu, select Run. In the field, type 
“<drive>:\setup” and click OK.

Note
<drive> is the letter associated with your CD-ROM 
drive. For example, D:\setup.

System response
Setup prepares the Wizard that guides you through 
the install program and displays the Welcome screen. 

Continued on next page

Step Action
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5 Click Next.

System response
The Choose Destination Location screen is displayed.

Continued on next page

Step Action
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6 Do you want to install Sterling Gentran:Director in the 
default folder?
■ If yes, click Next.

■ If no, click Browse to select the folder. Click OK to 
exit the Browse dialog box, and click Next.

System response
The Select Features screen is displayed.

Step Action
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7 Do the following:
■ Make sure both Sterling Gentran:Director 

Connection and Sterling Gentran:Director are 
selected.

■ If you have purchased the Sterling 
Gentran:Director FTP Option, click the check box 
to its left.

System response
The setup program installs Sterling Gentran:Director 
Connection and/or Sterling Gentran:Director and its 
components. The Sterling Gentran:Director 
Connection for the Internet Setup dialog box is 
displayed. 

Continued on next page

Step Action
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8 Do one of the following:
■ If you want to set up your mailbox, select Run the 

Mailbox Wizard and click Next. The Mailbox 
Wizard Welcome dialog box is displayed. 
Continue with Setting Up Mailboxes on page 32 
and then return here when that is complete.

■ If you do not want to set up your mailbox right 
now, select Skip Mailbox Setup and click Next. 
You can run the Wizard later using Connection 
Manager or Sterling Commerce:Mail®.

If you purchased the Sterling Gentran:Director FTP 
Option, continue with Step 9. Otherwise, continue with 
Step 10.

9  Click Next.

System response
The setup looks for an existing version of Java.
■ If it finds an existing version, the following screen 

is displayed. 

Make a selection and click Next.

Continued on next page

Step Action
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■ If it does not find an existing version of Java, the 
following dialog is displayed. 

■ If you want to install Java now, click Yes. 

■ If you click No, another dialog is displayed 
telling you that you will need to manually 
install Java. Click OK. 

Note: 
You will not be able to use the Sterling 
Gentran:Director FTP Option until a version of Java is 
install and your computer is restarted.

10 System response
The following screen is displayed. 

Continued on next page

Step Action
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11 Click Finish. 

System response
If you are not automatically installing Java for the 
Sterling Gentran:Director FTP Option, your installation 
is complete. Otherwise, the following License 
Agreement is displayed. 

12 Click Yes.

System response
The Choose Destination Location screen is displayed. 

Continued on next page

Step Action
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13 Keep the default or click Browse to select a new 
folder. Click Next.

System response
The Select Browsers screen is displayed. 

14 Select one of both of the browsers and click Next.

System response
The InstallShield Wizard Complete screen is 
displayed. 

15 Make a selection and click Finish.

Note:
The new version of Java will not be in effect until your 
computer is restarted.

Step Action
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Installing the Sterling Gentran:Director FTP Option 
Communication Scripts

Introduction If you have purchased the Sterling Gentran:Director FTP Option, 
you must install the Communication Scripts after completing the 
installation of Sterling Gentran:Director and Sterling 
Gentran:Director Connection.

Note:

The Sterling Gentran:Director FTP Option 
Communication Scripts will only install if you have 
installed Sterling Gentran:Director 5.5 and the Sterling 
Gentran:Director FTP Option.

Make sure you have
the following items

■ The Sterling Gentran:Director FTP Option Communication 
Scripts CD-ROM

Note: 

If you downloaded the Communication Scripts from the 
Internet, start with Step 3 in the procedure below.

Procedure To install Sterling Gentran:Director, complete the following steps:

Step Action

1 Insert the Sterling Gentran:Director FTP Option 
Communication Scripts CD-ROM into your CD-ROM 
drive. 

System response
The Sterling Gentran:Director FTP Option 
Communication Scripts Welcome screen is displayed.

Note
If the Welcome screen does not appear, go to Step 3.
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2 Click Next and go to Step 4.
Continued on next page

3 From the Start menu, select Run. In the field, type 
“<drive>:\setup” and click OK.

Note
<drive> is the letter associated with your CD-ROM 
drive. For example, D:\setup.

System response
Setup prepares the wizard that guides you through the 
install program and displays the Welcome screen. 

Continued on next page

Step Action
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4 Click Next.

System response
The Setup Type screen is displayed.

5 If you need to install the communication scripts for all 
of the VANs, select Complete. Continue with Step 8.
Otherwise, select Custom to install selected 
communication scripts. Continue with Step 6.

Continued on next page

Step Action
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6 Click Next.

System response
The Select Features screen is displayed.

Continued on next page

Step Action
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7 Select your VAN(s) and click Next.

System response
The Key entry screen for your selected VAN is 
displayed. 

Continued on next page

Step Action
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8 Enter the Key for your VAN and click Next.

System response
The Ready to Install the Program screen is displayed.

Continued on next page

Step Action
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9 Click Next.

System response
The InstallShield Wizard Complete screen is 
displayed.

10 Click Finish.

Step Action
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Setting Up Mailboxes 

Introduction After Sterling Gentran:Director and Sterling Gentran:Director 
Connection are installed, you can set up your mailbox profiles for 
Sterling Commerce:Mail and Sterling Gentran:Director using the 
Mailbox Wizard.

What is Sterling
Commerce:Mail?

Sterling Commerce:Mail is an e-mail application through which 
you can receive e-mail network reports. 

Selecting the Mailbox
Wizard

The Mailbox Wizard allows you to create a mailbox for Sterling 
Commerce:Mail and Sterling Gentran:Director. You can run the 
Mailbox Wizard from any one of the following locations:

■ The Sterling Gentran:Director Connection for the Internet 
setup dialog box that is displayed during product installation 
(For more information, see page 20.)

■ Sterling Connection Manager (For more information, see the 
application’s Online help.)

■ Sterling Commerce:Mail (For more information, see the 
application’s Online help.)

Creating mailbox
information

The following procedure describes how to use the Mailbox 
Wizard to create mailbox information within Sterling 
Gentran:Director Connection.

Important
Your mailbox information is assigned by IBM Customer Support 
and provided to you on a separate form. If you do not have this 
information, please contact IBM Customer Support for Sterling 
Gentran products.
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To create mailbox information, complete the following steps:

Step Action

1 On the Mailbox Wizard Welcome dialog box, type 
the name of your new mailbox in the provided field 
and click Next.

System response
The Personal Information dialog box is displayed. 

Note
Each mailbox name must be unique and can 
contain up to 30 alphanumeric characters.

Continued on next page
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2 Note
Your e-mail address and user name are assigned 
by IBM. Please see the Password card provided 
by IBM Customer Support for more information. 

Do the following:
■ Type your user name in the Name field. 

■ Type your e-mail address in the E-Mail 
address field.

■ Click Next.

System response
The Internet Mail Server dialog box is displayed.

3 Click the Primary Sterling B2B Collaboration 
Network Mail Server list box and select one of the 
following from the list:
■ The primary server. This server handles all of 

your inbound and outbound data. Go to 
Step 5.

■ User-Defined. This indicates that you want to 
use an alternate server to send and receive 
data. Continue with Step 4.

Step Action
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4 Click Next. 

System response
The User-Defined Mail Server dialog box is 
displayed. 

Continued on next page

Step Action
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5 Type the name of your primary Internet mail 
server in the Primary Mail Server field. If 
appropriate, type your secondary Internet mail 
server name in the Secondary Mail Server field.  
Click Next. 

System response
The User ID and Password dialog box is 
displayed. 

Continued on next page

Step Action
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6 Type your post office ID and password in the 
corresponding fields. Your ID and password work 
together to identify you to the mail server when it 
sends and retrieves your messages. Please see 
the Password card for more information. Click 
Next. 

System response
The Save New Mailbox dialog box is displayed.

7 Click Finish. 

System response
Your new mailbox has been created. If you were 
installing Sterling Gentran:Director, return to the 
procedure on page 21.

Step Action
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Changing the Default Password

System security is an important ongoing step in controlling who 
can log on to your system and which functions they can access. 
Security ensures the integrity of your data by limiting who can 
make changes to specific areas of the system. 

Recommendation
Change the default password for the system administrator login 
(ADMIN) as soon as possible to minimize security risks.

Complete the following steps to change the default system 
administrator password:

Step Description

1 Log on to Sterling Gentran:Director with the default 
system administrator login:
■ From the Start menu, select

Gentran Director\Sterling Gentran:Director.

■ Type ADMIN in the User Name box.

■ Type security in the Password box.

■ Click OK to log on to the system.

System response
The Sterling Gentran:Director EC Manager window 
is displayed.

2 From the Tools menu, select Preferences.

System response
The Preferences dialog is displayed.

Continued on next page
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3 Select the Change Password tab, as shown below: 

4 In the Old Password field, type security.

5 In the New Password field, type the new password.

6 In the Confirm New Password field, type the new 
password again. 

Note
If the Confirm New Password does not match the 
New Password, you will be prompted to type it 
again.

7 Once complete, click OK to save the changes.

System response
The system is updated and the next time you log on 
to the system using the ADMIN login, you must type 
the new password.

Step Description
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Adding Users to the System

You need to create a Sterling Gentran:Director login for anyone 
who needs to use the system.

Note
A new user can be set up only by a user with System 
Administration privileges. If you do not have these privileges, 
have your security administrator complete the setup.

Complete the following steps to add a new user:

Step Action

1 From the Sterling Gentran:Director Main Toolbar, 
select the System Configuration icon.

System response
The System Configuration dialog (System tab) is 
displayed.

Continued on next page
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2 Click the Users tab to access user options.

System response
The Users tab is displayed.

3 Click New.

System response
The Security Access dialog is displayed.

4 In the User ID box, type a unique logon identifier for 
this user.

Continued on next page

Step Action
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5 In the User Name box, type the name of this user.

6 In the Password box, type the user’s password.

7 In the Verify Password box, type the user’s 
password again.

8 In the Security Matrix section, select the areas of 
the system that the user needs to access.

9 Click OK to exit the Security Access dialog.

10 Click OK to exit the System Configuration program.

Step Action
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Validating your system

The Sterling Gentran:Director online help contains a section that 
describes the procedures you can use to validate your 
installation:  

Step Action

1 Log on to Sterling Gentran:Director.

2 Go to the EC Desktop.

3 Click the Help button on the lower right of the screen.

Note
You can also select Help from the main menu bar or 
press F1 at any time to display the online help.

4 Click the Contents tab.

5 Double-click Sterling Gentran:Director 5.5.

6 Double-click Getting Started.

7 Double-click Validating and Implementing Sterling 
Gentran:Director and complete the steps described.
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Reinstalling Sterling Gentran:Director

When to perform this
procedure

Perform this procedure only if you had problems with the 
installation or validation of your Sterling Gentran:Director release 
5.5.

To reinstall Sterling
Gentran:Director

To reinstall Sterling Gentran:Director, complete the following 
steps:

Step Action

1 Complete the steps for Installing Sterling 
Gentran:Director on page 16.

Note
This procedure installs products to the folder you 
installed to previously. IBM suggests that you 
accept the default folder shown on the Choose 
Destination Location window.

System Response
A message is displayed if the installation program 
detects existing Sterling Gentran:Director 
components already installed on your PC. 

2 To continue with installation and overwrite the 
Sterling Gentran:Director components that were 
detected, click Yes.

Note
To exit the installation program without completing 
the installation, click No.

System Response
If the Director Executive is running, a message 
asking if you want to stop the Director Executive is 
displayed. 

Continued on next page
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3 Click Yes to continue with the installation.

System Response
The setup program installs the Sterling 
Gentran:Director Connection and Sterling 
Gentran:Director software, and the Mailbox Wizard 
window is displayed. 

Reference
For information on setting up mailbox profiles, see 
Setting Up Mailboxes on page 32.

Step Action
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Chapter 2

Upgrade for Existing Customers

Installation Roadmap

The following table describes the order of tasks to complete.

Stage Description Section

1 Exit Sterling Gentran:Director 
Connection and Sterling 
Gentran:Director.

2 Back up your Sterling 
Gentran:Director database.

Backing up Your 
Sterling 
Gentran:Director 
System on page 
48

3 Stop the Sterling Gentran:Director 
Executive or the Sterling 
Gentran:Director Service.

Stopping the 
Sterling 
Gentran:Director 
Executive on 
page 57

4 Upgrade Sterling Gentran:Director 
Connection and Sterling 
Gentran:Director.

Upgrading 
Sterling 
Gentran:Director 
Connection and 
Sterling 
Gentran:Director 
on page 58
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Backing up Your Sterling Gentran:Director System

This section provides instructions for backing up your entire 
Sterling Gentran:Director system. You should back up the 
database and stop Sterling Gentran:Director Executive before 
upgrading to Sterling Gentran:Director 5.5.

Before you begin Before you begin backing up your Sterling Gentran:Director 
database, complete the following:

When you are done creating the appropriate folders, you are 
ready to begin backing up Sterling Gentran:Director database.

Step Action

1 Create a folder on your hard drive. Name the folder 
C:\BackupGentran.

2 Create the following subfolders within the 
BackupGentran folder using the names indicated:
■ Partners

■ Templates

■ Scripts

■ Database

■ Documents

■ IntIn

■ IntOut

■ TransIn

■ Bin
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Backing up Your
Partner Profiles

Backing up
Translation Objects

Step Action

1 Log on to Sterling Gentran:Director and click Partners.

2 Click the name of a partner.

3 Click Export. The Export File Build screen displays.

4 Locate the File Name field and write down the name of 
the partner profile. The file name should end with .PAR.

5 Click Save.

Note
The .PAR files are saved to
C:\DirectorConnection\Partners

6 Repeat steps 2 – 5 for the remaining partner profiles.

7 When you have exported all of your partner profiles, 
copy these profiles to C:\BackupGentran\Partners or 
to a floppy disk.

Caution
Do not use the move function to perform this task.

Step Action

1 Click View > Translation Objects.

2 Click the name of a translation object.
Continued on next page
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3 Click View to review the details associated with that 
translation object.

4 Locate the File Name field and write down the name of 
the translation object (for example, FIN162022.TPL).

Note
Some files may have extensions such as .t00, .t01, 
.t02, etc. When writing down the name, use the 
extension .TPL for all translation objects.

5 Repeat steps 2 – 4 for the remaining translation 
objects.

6 Click Close.

7 Click Tools > Configuration > Imports.
Continued on next page

Step Action
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Backing up
Communication Ports,

Profiles, and Scripts

To back up your communication ports, profiles, and scripts, 
gather the following information:

Ports 

8 Write down the File Path and Translation Object 
Description. You can find the Translation Objects in 
View > Translation Objects. If you cannot find the 
description, complete the following:
a. Click Sort.
b. Clear the Hide System Translation Objects 

checkbox.
c. Click OK. 

This will display all of the system templates. Your 
system import template should now be listed. Repeat 
steps 2 – 4 to copy down all translation object file 
names.

Note
The .TPL files are saved to
C:\DirectorConnection\RegTransobj

9 Copy the files to C:\BackupGentran\Templates or to a 
floppy disk.

Caution
Do not use the move function to perform this task.

Step Action

Step Action

1 Click Tools > Communications > Ports.

2 Click the name of the port.

3 Click Setup.
Continued on next page



Backing up Your Sterling Gentran:Director System

52 May 2011 IBM Sterling Gentran:Director Connection Getting Started Guide

Profiles 

4 Write down the port name and all associated settings.

5 Click Cancel.

6 Repeat steps 2 – 5 for all port profiles.

Step Action

1 Click Tools > Communications > Profiles.

2 Click the name of the profile.

3 Click Setup.

4 Write down the profile name and all associated 
settings, including:
■ Profile Type

■ Modem Number (if applicable)

■ Port Profile (if applicable)

■ File Copy Name (if applicable)

■ IP Address and Socket (if applicable)

5 Click Logon Script (if applicable).

6 Locate the file name on the title bar at the top of the 
window. Write down the file name using the extension 
.SCR.

7 Click Cancel.

8 Repeat steps 6 – 7 for Receive Only Script and Send 
Receive Script.

Continued on next page

Step Action
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Scripts 

9 Click Script Variables.

10 Write down the contents of all the variables that contain 
information.

11 Click Configure Exchange (if applicable).

12 Write down all settings indicated.

Note
If you use IBM® Sterling B2B Collaboration Network, 
you may need to find or request a copy of your User ID 
and Password for your Sterling Gentran:Director 
Connection setup.

13 Click Advanced>>.

14 Write down all of the information for:
■ Pre-Processor (if applicable)

■ Pre-Post Processor (if applicable)

15 Repeat steps 2 – 14 for all profiles.

Step Action

1 Open the folder labeled 
C:\DirectorConnection\Bin\Commscr.

2 Verify that the folder contains the same names as those 
in your notes from Step 6 on page 52.

3 When you have verified folder contents, copy the .SCR 
files to C:\BackupGentran\Scripts or to a floppy disk.

Caution
Do not use the move function to perform this task.

Step Action
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Backing up the EDI
Data Received from
Trading Partner(s)

Closing Programs

Step Action

1 Open the folder labeled 
C:\DirectorConnection\TransIn.

2 Verify the folder contents.

3 When you have verified folder contents, copy the .EDI 
files to C:\BackupGentran\TransIn or to a floppy disk.

Caution
Do not use the move function to perform this task.

Step Action

1 Exit Sterling Gentran:Director and all other programs.

2 Stop Sterling Gentran:Director Executive. See 
Stopping the Sterling Gentran:Director Executive 
on page 57.
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Backing up the Access
Database (Optional)

You may want to back up your Access Database to retain 
document listings in the InDrawer, OutDrawer, and Interchanges. 

If you want to view the EDI data for the documents listed in the 
InDrawer, OutDrawer, and Interchanges, copy the folders and 
their contents to the corresponding C:\BackupGentran\ folder, 
as listed below:

■ C:\DirectorConnection\Documents
■ C:\DirectorConnection\IntIn
■ C:\DirectorConnection\IntOut

Note:
For instructions on backing up Process Control (Unattended) and 
Partner Tables, please contact IBM Customer Support.

Step Action

1 Navigate to C:\DirectorConnection\Database.

2 Copy the Sterling Gentran:Director.mdb files to 
C:\BackupGentran\Database.

Caution
Do not use the move function to perform this task.
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Backing up the Bin
Directory

Stage Description

3 Navigate to C:\DirectorConnection\Bin.

4 Copy the contents of this directory to 
C:\BackupGentran\Bin.

Caution
Do not use the move function to perform this task.
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Stopping the Sterling Gentran:Director Executive

You must stop Sterling Gentran:Director Executive before you 
can install the Sterling Gentran:Director 5.5 upgrade. 

Step Action

1 Double-click the IBM icon on your system tray.

2 Select Stop Director Executive.

3 Click Yes to stop the application.

System Response
The Executive icon no longer displays in the Windows 
toolbar.
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Upgrading Sterling Gentran:Director Connection and 
Sterling Gentran:Director

The installation program upgrades both Sterling Gentran:Director 
Connection and Sterling Gentran:Director.

Step Action

1 Insert the Sterling Gentran:Director Connection CD-
ROM into your CD-ROM drive.

System Response
The installation program automatically starts.
If it does not automatically start, continue with step 2. 
Otherwise, continue with step 3.

2 If the installation program does not start, complete the 
following steps:
a. From the Start menu, click Run.
b. Enter <drive_letter>:\setup.exe

where: <drive_letter> is the drive letter for your 
CD-ROM drive (for example, D:\ ).

3 To complete the installation, do one of the following:
■ If Sterling Gentran:Director 5.4 and Sterling 

Gentran:Director Connection 6.1.4 are installed on 
your computer and you want to update both 
products, click Next until you have completed the 
installation process. 

■ If you do not have Sterling Gentran:Director 
Connection 6.1.4 installed on your computer and 
want to install only Sterling Gentran:Director 5.5, 
on the Select Features screen, de-select Sterling 
Gentran:Director Connection and click Next until 
you have completed the installation process.
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Restoring Your Sterling Gentran:Director System 
from Backup

When to perform this
procedure

You do not need to perform a restore if the Sterling 
Gentran:Director Connection 6.2 and Sterling Gentran:Director 
5.5 upgrade completes successfully. However, if you experienced 
problems completing the installation, you may need to restore 
your system to its original state. Perform the following procedures 
only if you experienced problems during installation.

Prerequisites Complete the following steps before restoring your database from 
backup. 

Step Action

1 Close Sterling Gentran:Director and stop Sterling 
Gentran:Director Executive. See Stopping the 
Sterling Gentran:Director Executive on page 57.

2 Rename the existing database to a new name (for 
example, Sterling Gentran:Director.old). However, if 
you do not want to maintain two copies of a database, 
you can delete the existing copy and then copy the 
backup database version to the database folder.

3 Navigate to C:\BackupGentran\.
Continued on next page
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Re-registering
Translation Objects

4 Copy the following backup folders and their contents 
from C:\BackupGentran\ to the associated folders 
located in the C:\DirectorConnection\ folder: 
■ C:\DirectorConnection\Database 

(one file GentranDirector.mdb)

■ C:\DirectorConnection\Documents

■ C:\DirectorConnection\IntIn

■ C:\DirectorConnection\IntOut

Note
You do not need to copy the contents of the folders 
back if you are re-installing the Sterling 
Gentran:Director software over an existing installation. 
Only restore folders on a fresh re-install, unless told 
otherwise by IBM Customer Support.

Step Action

Step Action

1 Open Sterling Gentran:Director.

2 Click View > Translation Objects.

3 Click New.

4 Navigate to C:\BackupGentran\Templates.

5 Select all .TPL files and click Open.

6 Click Yes if you are prompted to overwrite any file.



Restoring Your Sterling Gentran:Director System from Backup

IBM Sterling Gentran:Director Connection Getting Started Guide           May 2011 61

Rebuilding
Communications Ports

and Profiles

Ports 
If you are reinstalling to the same computer, you can recreate the 
ports exactly as they were originally. If you are re-installing to a 
different computer, you will need to determine the port(s) and 
associated modem(s) to modify the port information accordingly. 
You may also need to modify the initialization strings if the 
modem is different.

Step Action

1 Click Tools > Communications > Ports.

2 Click New.

3 Enter your port name.

Note
Use a port name from the list of port names you wrote 
down in the Ports procedure, Step 4 on page 52. This 
list should also have the settings required to complete 
step 5 of this procedure.

4 Click OK.

5 Enter the information for all of the settings.

6 Click OK.

7 Repeat steps 2 – 6 for all port entries.

8 When finished, click Close.
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Profiles and Scripts 

Step Action

1 Copy all .SCR files from:
C:\BackupGentran\Scripts
to:
C:\DirectorConnection\Bin\Commscr

2 Click Tools > Communications > Profiles.

3 Click New.

4 Enter your profile name.

Note
Use a profile name from the list of profile names you 
wrote down in the Profiles procedure, Step 4 on 
page 52. This list should also have the settings 
required to complete step 6 of this procedure.

5 Click OK.

6 Enter the information for all of the settings including the 
Advanced>> section.

7 Click Logon Script (if applicable).

8 Click Import and select the logon script file associated 
with that profile.

9 Click Open.

10 Click Save.

11 Click Receive Only Script (if applicable).
Continued on next page
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12 Click Import and select the receive only script file 
associated with that profile.

13 Click Open.

14 Click Save.

15 Click Send Receive Script (if applicable).

16 Click Import and select the send receive script file 
associated with that profile.

17 Click Open.

18 Click Save.

19 Click Script Variables (if applicable).

20 Type in the variables associated with that profile.

21 Click OK to save the profile.

22 Repeat steps 3 – 21 for all of the profiles.

23 Click Configure Exchange (if applicable).

24 Fill in all of the settings.

Note
Use the setting information you wrote down in the 
Profiles procedure, Step 12 on page 53.

Step Action
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Restoring Partners (if
applicable)

If you did not restore your database, complete the following steps 
to restore your partners: 

Step Action

1 Copy all .PAR files from:
C:\BackupGentran\Partners
to:
C:\DirectorConnection\Partners

2 Click Partners.

3 Click Import.

System Response
The Import File Select windows displays.

4 Select the partner you want to import and click Open.

5 Click Save.

6 Select the correct communication profile for that partner 
(if blank).

7 Click Save or press Enter until a window displays 
indicating the import process is complete.

8 Click OK.

9 Repeat steps 3 – 8 for all partners.
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Reprocessing Old Data
(if applicable)

For additional information, contact IBM Customer Support.

Step Action

1 Click Commands > Process File in Director.

2 Browse to C:\BackupGentran\TransIn and select the 
file you want to reprocess.

3 Click Open.
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Upgrading Sterling Gentran:Director and Changing 
Systems

This section contains instructions for using the Gentran DataBase 
Computer Name Sync utility to change the computer name stored 
in the Sterling Gentran:Director database to the new computer 
name. 

When to perform this
procedure

Use this section only if you are moving your Sterling 
Gentran:Director system to a new computer as part of your 
upgrade process. 

Prerequisites You must complete the following tasks before running this utility:

■ Install Sterling Gentran:Director 5.5 on the new computer.

■ Complete the backup on the old Sterling Gentran:Director 
system. 

Reference
If you are not familiar with the backup and restore process, see 
the Knowledge Base on the Support Center Web site for more 
information. In Knowledge Base, you can use the Quick Search 
function to locate information about backup and restore 
procedures. For more information about the Support Center, see 
Customer Support on page 4.
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Running the utility Complete the following steps to run the Gentran DataBase 
Computer Name Sync utility. 

Step Action

On the new computer (where Sterling Gentran:Director 5.5 
is installed):

1 Navigate to the Sterling Gentran:Director Database 
folder. If you accepted the default paths during 
installation, this folder is:
C:\DirectorConnection\Database

2 Change the file named GentranDatabase.mdb to 
NEWGentranDatabase.mdb.

On the old computer (where your existing Sterling 
Gentran:Director system is located):

1 Exit Sterling Gentran:Director, if necessary. If the 
Director Executive is running, stop it (see Stopping 
the Sterling Gentran:Director Executive on page 
57).

2 Navigate to the Sterling Gentran:Director Database 
folder on the Sterling Gentran:Director system. If you 
accepted the default paths during installation, this 
folder is:
C:\Program Files\COMMERCE Connection32\Database

3 Copy the file named GentranDatabase.mdb from the 
old computer to the Sterling Gentran:Director 
Database folder on the new computer. If you accepted 
the default paths during installation, this folder is:
C:\DirectorConnection\Database

Continued on next page
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On the new computer (where Sterling Gentran:Director 5.5 
is installed):

1 Put the Sterling Gentran:Director Connection CD-
ROM in the CD-ROM drive of the new computer. 

2 Navigate to the Support Utilities directory on the 
CD-ROM and open the folder.

3 In the Support directory, double-click the executable 
file called GentranDBComputerNameSync.exe. 
A dialog box is displayed.

4 Click OK. 
The utility starts and the 
GentranDBComputerNameSync dialog box is 
displayed. 

5 Click the Sync Gentran DB with Computer Name 
button to run the utility.
When the utility is finished, the message Done! is 
displayed. 

6 Click Quit to close the message box, then click OK to 
exit the program. 

Continued on next page

Step Action
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7 To test that the utility ran successfully, try running a 
Process Control session that includes a 
communication session.
■ If you do not receive an “Inconsistent computer 

names” message, the utility successfully updated 
the computer name in the Sterling Gentran 
database. 

■ If the “Inconsistent computer names” message is 
displayed after completing this procedure, call 
Sterling Gentran:Director Support for assistance. 
See Customer Support on page 4.

Step Action
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Appendix A

Frequently Asked Questions

This appendix contains answers to some frequently asked 
questions about installation, tasks in the Pre-installation 
Checklist, and other topics. 

For more questions and answers, see the Sterling 
Gentran:Director online help and the Support Center Web site 
located at www.sterlingcommerce.com. 

How do I find out what
version of Windows is

running on the
computer?

1. From the Windows Start menu, select Settings > Control 
Panel. 
(If you are using a Windows XP system, just select Control 
Panel.)

2. Double-click System. 

The System Properties window is displayed. It lists the 
name, version, and service pack level of the Windows 
software that is running on the computer.

3. Click Cancel to exit the System Properties window. 

How do I find out what
version of Internet

Explorer is running on
the computer?

1. From the Windows Start menu, select Programs > Internet 
Explorer.

2. From the Internet Explorer Help menu, select About 
Internet Explorer.
The Help About is window displayed. It lists the Internet 
Explorer version and service pack level running on the 
computer.

3. Click OK to exit the Help About window. 
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How do I find out what
version of MDAC is

running on the
computer?

1. From the Windows Start menu, select Settings > Control 
Panel. 
(If you are using a Windows XP system, just select Control 
Panel.) 

2. Double-click Administrative Tools, then double-click 
ODBC. 

3. The ODBC Data Source Administrator window is displayed.

4.  Click the About tab. 

5. Locate the Administrator in the Description field. 
6. Find the version listed to the right of Administrator and 

compare that version to the ones in the following table. 

MDAC Versions

ODBC 
Administrator 

Version
Do you need to 

upgrade MDAC?

2.8 
(file version 
2.80.1022.3)
(product version 
5.50.4132.500)

3.525.1022.0 
(included on the 
Sterling 
Gentran:Director 
5.5 CD-ROM)

Can be used with 
Sterling 
Gentran:Director 5.5. 
You do not need to 
upgrade MDAC. 

2.7 RTM 
(2.70.7713.4)

3.520.7713.0 

2.6 SP1 
(2.61.7326.6)

3.520.7326.0 

Continued on next page
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7. Click Cancel to exit the Data Source Administrator window. 

How do I check if
ports 110 and 25 are

open?

Customers in the U.S.
To check port 110:

1. Make sure you are connected to the Internet.

2. From the Start menu, select Run. 

3. Type the following in the Open field:

telnet primary.gts.globalec.com 110

2.6 RTM 
(2.60.6526.3)

3.520.6526.0 Cannot be used with 
Sterling 
Gentran:Director 5.5. 
Requires upgrade.

See Installing 
Microsoft Data 
Access Components 
on page 14 for 
instructions. 

2.5 SP2 
(2.52.6019.0)

3.520.6019.0

2.5 SP1 
(2.51.5303.5)

3.520.5303.2

2.5 RTM 
(2.50.4403.12)

3.520.4403.2

2.1 SP2 
(2.1.2.4202.3)

3.510.4202.0

2.1 SP1a 
(2.1.1.3711.11)

3.510.3711.0

2.1 RTM 
(2.10.3513.2)

3.510.3513.0

2.0 sp2 3.510.3002.23

MDAC Versions

ODBC 
Administrator 

Version
Do you need to 

upgrade MDAC?
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4. Click OK.
A telnet session window is displayed. If you see the following 
message, port 110 is open:

+OK Welcome 

5. Close the window to exit.

To check port 25:

1. Make sure you are connected to the Internet.

2. From the Start menu, select Run. 

3. Type the following in the Open field:

telnet primary.gts.globalec.com 25
4. Click OK.

A telnet session window is displayed. If you see a message 
similar to the following, port 25 is open:

220 gts.globalec.com COMMERCE:Exchange 
ESMTP/POP3 Server version 1.0 Ready

5. Close the window to exit.

Customers in Canada: 
To check port 110:

1. Make sure you are connected to the Internet.

2. From the Start menu, select Run. 

3. Type the following in the Open field:

telnet primary.ca.globalec.com 110
4. Click OK.

A telnet session window is displayed. If a message 
beginning with “+OK” is displayed, port 110 is open.

5. Close the window to exit.
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To check port 25:

1. Make sure you are connected to the Internet.

2. From the Start menu, select Run. 

3. Type the following in the Open field:

telnet primary.ca.globalec.com 25
4. Click OK.

A telnet session window is displayed. If you see the 
following message, then port 25 is open.

220 tor1relaypri.ca.globalec.com ESMTP Server 
[current date and time and other information 
may also be displayed here] Ready

5. Close the window to exit.
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Notices
This information was developed for products and services offered in the U.S.A. 

IBM may not offer the products, services, or features discussed in this document in 
other countries. Consult your local IBM representative for information on the products 
and services currently available in your area. Any reference to an IBM product, 
program, or service is not intended to state or imply that only that IBM product, 
program, or service may be used. Any functionally equivalent product, program, or 
service that does not infringe any IBM intellectual property right may be used instead. 
However, it is the user's responsibility to evaluate and verify the operation of any non-
IBM product, program, or service. 

IBM may have patents or pending patent applications covering subject matter 
described in this document. The furnishing of this document does not grant you any 
license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.S.A.

For license inquiries regarding double-byte character set (DBCS) information, contact 
the IBM Intellectual

Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law

IBM Japan Ltd.

1623-14, Shimotsuruma, Yamato-shi
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Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other 
country where such provisions are inconsistent with local law: 
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS 
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER 
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS 
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or 
implied warranties in certain transactions, therefore, this statement may not apply to 
you. 

This information could include technical inaccuracies or typographical errors. 
Changes are periodically made to the information herein; these changes will be 
incorporated in new editions of the publication. IBM may make improvements and/or 
changes in the product(s) and/or the program(s) described in this publication at any 
time without notice. 

Any references in this information to non-IBM Web sites are provided for 
convenience only and do not in any manner serve as an endorsement of those Web 
sites. The materials at those Web sites are not part of the materials for this IBM 
product and use of those Web sites is at your own risk. 

IBM may use or distribute any of the information you supply in any way it believes 
appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of 
enabling: (i) the exchange of information between independently created programs 
and other programs (including this one) and (ii) the mutual use of the information 
which has been exchanged, should contact:

IBM Corporation

J46A/G4

555 Bailey Avenue

San Jose, CA__95141-1003

U.S.A. 

Such information may be available, subject to appropriate terms and conditions, 
including in some cases, payment of a fee. 
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The licensed program described in this document and all licensed material available 
for it are provided by IBM under terms of the IBM Customer Agreement, IBM 
International Program License Agreement or any equivalent agreement between us. 

Any performance data contained herein was determined in a controlled environment. 
Therefore, the results obtained in other operating environments may vary 
significantly. Some measurements may have been made on development-level 
systems and there is no guarantee that these measurements will be the same on 
generally available systems. Furthermore, some measurements may have been 
estimated through extrapolation. Actual results may vary. Users of this document 
should verify the applicable data for their specific environment. 

Information concerning non-IBM products was obtained from the suppliers of those 
products, their published announcements or other publicly available sources. IBM has 
not tested those products and cannot confirm the accuracy of performance, 
compatibility or any other claims related to non-IBM products. Questions on the 
capabilities of non-IBM products should be addressed to the suppliers of those 
products. 

All statements regarding IBM's future direction or intent are subject to change or 
withdrawal without notice, and represent goals and objectives only. 

This information is for planning purposes only. The information herein is subject to 
change before the products described become available. This information contains 
examples of data and reports used in daily business operations. To illustrate them as 
completely as possible, the examples include the names of individuals, companies, 
brands, and products. All of these names are ficticious and any similarity to the names 
and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which 
illustrate programming techniques on various operating platforms. You may copy, 
modify, and distribute these sample programs in any form without payment to IBM, 
for the purposes of developing, using, marketing or distributing application programs 
conforming to the application programming interface for the operating platform for 
which the sample programs are written. These examples have not been thoroughly 
tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, 
serviceability, or function of these programs. The sample programs are provided "AS 
IS", without warranty of any kind. IBM shall not be liable for any damages arising out 
of your use of the sample programs. 
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Each copy or any portion of these sample programs or any derivative work, must 
include a copyright notice as follows:

© IBM 2011. Portions of this code are derived from IBM Corp. Sample Programs. 
© Copyright IBM Corp. 2011.

If you are viewing this information softcopy, the photographs and color illustrations 
may not appear.
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Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of 
International Business Machines Corp., registered in many jurisdictions worldwide. 
Other product and service names might be trademarks of IBM or other companies. A 
current list of IBM trademarks is available on the Web at “Copyright and trademark 
information” at www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered 
trademarks or trademarks of Adobe Systems Incorporated in the United States, and/or 
other countries.

IT Infrastructure Library is a registered trademark of the Central Computer and 
Telecommunications Agency which is now part of the Office of Government 
Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo, 
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or 
registered trademarks of Intel Corporation or its subsidiaries in the United States and 
other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, 
or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of 
Microsoft Corporation in the United States, other countries, or both.

ITIL is a registered trademark, and a registered community trademark of the Office of 
Government Commerce, and is registered in the U.S. Patent and Trademark Office.

UNIX is a registered trademark of The Open Group in the United States and other 
countries.

Java and all Java-based trademarks and logos are trademarks or registered trademarks 
of Oracle and/or its affiliates.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the 
United States, other countries, or both and is used under license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are trademarks 
of HP, IBM Corp. and Quantum in the U.S. and other countries.

www.ibm.com/legal/copytrade.shtml
www.ibm.com/legal/copytrade.shtml
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Connect Control Center®, Connect:Direct®, Connect:Enterprise, Gentran®, 
Gentran:Basic®, Gentran:Control®, Gentran:Director®, Gentran:Plus®, 
Gentran:Realtime®, Gentran:Server®, Gentran:Viewpoint®, Sterling Commerce™, 
Sterling Information Broker®, and Sterling Integrator® are trademarks or registered 
trademarks of Sterling Commerce, Inc., an IBM Company.

Other company, product, and service names may be trademarks or service marks of 
others.
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